DCS-1000
Internet Camera
Manual
Contents

CONTENTS ......................................................................................................................................1
ABOUT THIS GUIDE.........................................................................................................................3
INTRODUCTION.................................................................................................................................3
SYSTEM REQUIREMENT ..................................................................................................................3

Recommended: PC or Notebook to Access the Internet Camera .................................................3
FEATURES AND BENEFITS ............................................................................................................4

PHYSICAL DESCRIPTION ..............................................................................................................5

FRONT PANEL ...............................................................................................................................5
REAR PANEL .................................................................................................................................6
BOTTOM PANEL ...........................................................................................................................7

UNPACKING THE DCS-1000 ..........................................................................................................8

CONNECTING DCS-1000 TO THE CAMERA STAND .................................................................8

HARDWARE INSTALLATION .........................................................................................................9

SECURITY ........................................................................................................................................10

SOFTWARE INSTALLATION .......................................................................................................11

WEB CONFIGURATION ..................................................................................................................11
MAIN MENU IMAGE ......................................................................................................................12
SYSTEM ADMINISTRATION ..........................................................................................................12

System Administration - System .................................................................................................13
System Administration - Image ......................................................................................................18
System Administration - Users ......................................................................................................19
System Administration – DateTime ...............................................................................................21
System Administration – Trigger ..................................................................................................23
System Administration - Information ............................................................................................26
System Administration - Tools ......................................................................................................26

VIEW IMAGE – ACTIVEX MODE ...............................................................................................27
VIEW IMAGE – JAVA MODE ..........................................................................................................29

IPVIEW APPLICATION INSTALLATION ..................................................................................30

INSTALLATION .............................................................................................................................30

IPVIEW – GETTING STARTED .......................................................................................................35

IP VIEW ..........................................................................................................................................35

HOW TO CHANGE PASSWORD ..................................................................................................36

Change Password ..........................................................................................................................36
About This Guide

This manual describes DCS-1000, including a description of the features, as well as the installation procedures and web configuration. Included in the manual are the operating procedures for the IPView application.

Introduction

Thank you for the purchase of DCS-1000 connecting directly to an Ethernet or Fast Ethernet. It is different from the conventional PC Camera, DCS-1000 is a standalone system with built-in CPU and web-based solutions providing a low cost solution that can transmit high quality video images for monitoring. DCS-1000 can be managed remotely, accessed and controlled from any PC/Notebook over the Intranet or Internet via a web browser. The simple installation procedures and web-based interface offers easy integration to your network application environments coupled with many applications such as remote monitoring for a cost-effective solution.

System Requirement

Local Area Network: 10Base-T Ethernet or 100Base TX Fast Ethernet

Recommended: PC or Notebook to Access the Internet Camera

Web Browser:

- Internet Explorer 5.0 or above (ActiveX & JAVA Mode – Image View for Windows OS and JAVA Mode – Image View for other OS)
- Netscape 6.0 or above (JAVA Mode – Image View)
- CPU: Pentium II, 266 MHz or above
- Memory Size: 32 MB (64 MB recommended)
- VGA card resolution: 800x600 or above
IPView Application:

- Win 98, Win 98 SE, Win 2000, Win Me, Win XP
- Pentium III, 450 MHz or above
- Memory Size of 128 MB (256 MB recommended)
- VGA card resolution of 800x600 or above

Features and Benefits

This section describes the features and benefits of the DCS-1000

Simple To Use
DCS-1000 is a standalone system with built-in CPU requiring no special hardware or software such as PC frame grabber cards. DCS-1000 supports both ActiveX mode for Internet Explorer and Java mode for Internet Explorer and Netscape Navigator. Therefore, all that is required is a web browser software such as Internet Explorer 5.0 or above or Netscape 6.0 or above. Just plug and view the picture from your DCS-1000 with a valid IP Address.

Support Variety of Platforms
Supporting TCP/IP networking, SMTP e-mail, HTTP and other Internet related protocols. DCS-1000 can be utilized in a mixed operating system environment such as Windows, Unix, and Mac. It can be integrated easily into other www/Intranet applications.

Web Configuration
Applying a standard web browser, administrator can configure and manage DCS-1000 directly from its own web page via the Intranet or Internet. Up to 64 users name and password are permitted with privilege setting controlled by the administrator.

Remote Utility
Powerful IPView application assigns administrator with a pre-defined user ID and password whom can modify DCS-1000 settings from the remote site via Intranet or Internet. When new firmware is available you can also upgrade remotely over the network for added convenience. Users are also allowed to monitor the image, and take snapshots.
Connection to External Devices
Supporting auxiliary Input/Output Connector, you can connect DCS-1000 to a variety of external devices such as IR-sensors, switches and alarm relays. One can combine with programmable alarming facilities to develop a variety of security applications that are triggered on alarm-based events. DCS-1000 provides up to two in/out external devices for connectivity.

Broad Range of Applications
With today’s high-speed Internet services, DCS-1000 can provide the ideal solution for live video images over the Intranet and Internet for remote monitoring. DCS-1000 allows remote access from a web browser for live image viewing and allows administrator to manage and control DCS-1000 anywhere and any time in the world. Apply DCS-1000 to monitor various objects and places such as homes, offices, banks, hospitals, child-care centers, amusement parks and other varieties of industrial and public monitoring. DCS-1000 can also be used for intruder detection, capture still images and video images for archiving and many more applications.

Physical Description
This section describes the externally visible features of DCS-1000.

Front Panel

Power LED
LAN LED
Manual Focus Ring

Power LED
The Power LED is positioned on the right side of DCS-1000’s lens while facing DCS-1000. Steady blue confirms DCS-1000 is powered on.

Note:
There are three settings for the Power LED to control the light illumination for
monitoring purpose from Normal / Off / Dummy. Please refer to the Web Configuration section for detailed information and usage.

**LAN LED**
The LAN LED is positioned on the far right side of the DCS-1000’s lens while facing DCS-1000. It is located right of the Power LED. Steady orange confirms good connection to LAN connectivity.

Dependent on the data traffic the LED will begin to flash to indicate DCS-1000 is receiving/transceiving from/to the LAN or network.

**Note:**
There are three settings for the LAN LED to control the light illumination for monitoring purpose from Normal / Off / Dummy. Please refer to the Web Configuration section for detailed information and usage.

**Rear Panel**

**Network Cable Connector**
DCS-1000’s rear panel features an RJ-45 connector for connections to 10Base-T Ethernet cabling or 100Base-TX Fast Ethernet cabling (which should be Category 5 twisted-pair cable). The port supports the NWay protocol, allowing DCS-1000 to automatically detect or negotiate the transmission speed of the network.
DC Power Connector
The DC power input connector is located on DCS-1000’s rear panel and is labeled **DC 5V** with a single jack socket to supply power to DCS-1000.

Reset Button
Reset will be initiated when the reset button is pressed once and Power LED begins to flash.

Factory Reset will be initiated when the reset button is pressed continuously for three seconds or when Power LED begins to light up. Release the reset button and the Power LED will begin to flash indicating DCS-1000 is changing to factory reset. When factory reset is completed the IP address will return to the default setting as 192.168.0.20.

I/O Connector
There are four I/O connectors, two for input and two for output situated on the rear panel. The I/O connectors provide the physical interface to send and receive digital signals to a variety of external alarm devices. *Please refer to the User’s Guide appendix for detailed information.*

Bottom Panel

Screw Hole
Located on the bottom panel of DCS-1000 the screw hole is used to connect the camera stand onto DCS-1000 by attaching the screw head on the camera stand into the screw hole of DCS-1000.
Unpacking The DCS-1000

Carefully remove all items from the package. In addition to this User’s Guide, be certain that you have:

- One Internet Camera
- One Installation CD-ROM
- One AC power adapter suitable for your country’s electric power
- One Camera Stand
- One Category 5 Ethernet Cable
- This Manual

If any item is missing, or if you find any damage or mismatch, promptly contact your dealer for assistance.

Connecting DCS-1000 to the Camera Stand

DCS-1000 comes with a camera stand with a swivel ball screw head that can be attached to DCS-1000's bottom screw hole. Attach the camera stand to DCS-1000 and station it for your application. There are three holes located in the base of the camera stand allowing the DCS-1000 to be mounted on the ceiling or any wall securely.
Hardware Installation

This section describes the Hardware installation procedure for DCS-1000.

1. Connect an Ethernet cable

Connect an Ethernet cable to the network cable connector located on DCS-1000’s rear panel and attach it to the network.

2. Attach the external power supply

Attach the external power supply to the DC power input connector located on DCS-1000’s rear panel and is labeled DC 5V and connect it to your local power supply.

Note:
Confirm power source is supplied from the LED indicators label Power on DCS-1000 is illuminated.
Security

To ensure the highest security and prevent unauthorized usage of DCS-1000 the Administrator has the exclusive privilege to access the System Administration for settings and control requirements to allow users the level of entry and authorize the privileges for all users. DCS-1000 supports multi-level password protection and access to DCS-1000 is strictly restricted to defined users whom has a "User Name" and "User Password" which is assigned by the Administrator.

Administrator can release a public user name and password so when remote users access DCS-1000 they will have the right to view the image transmitted by DCS-1000.

Note:
When DCS-1000 is used for the first time it is highly recommended the Administrator sets the "Admin ID" and "Admin Password" to constrain user’s access to DCS-1000 since the Default settings are Null String. Once the ID and Password are defined only the Administrator has the access to management DCS-1000. This procedure should be done as soon as possible since the security features with DCS-1000 will not be enabled until the "Admin ID" and "Admin Password" is defined.
Software Installation

This section describes the Software installation procedure of DCS-1000 for Web Configuration and IPView Application.

Web Configuration

- DCS-1000 must be configured through its built-in Web-based Configuration.

Extensive knowledge of LAN will be helpful in setting up DCS-1000

From the web browser enter the default IP address to access the Home screen of DCS-1000 to configure your DCS-1000 type “http://192.168.0.20” in the address box. The number is the default IP address of your DCS-1000. Press Enter.

Note:
The PC’s IP address must correspond with the DCS-1000’s IP address in the same segment (i.e. PC=192.168.0.5, Camera=192.168.0.20) for the two devices to communicate.
Main Menu Image

After the default IP address is entered from the browser DCS-1000 Home screen will appear with a still image. There will be three options to choose from to set-up and view your DCS-1000 and they are as follows:

- View Image – ActiveX Mode
- View Image – Java Mode
- System Administration

System Administration

Click on “System Administration” from the Home screen to access the settings required for DCS-1000.

There will be several options in the System menu bar to choose from to set your DCS-1000 and they are as follows:

- System
- Image
- Users
- DateTime
- Trigger
- Information
- Tools
**System Administration - System**
The System menu contains commands for settings that are required for inputting key details to set-up DCS-1000 for operation.

Click on "**System**" in the system administration menu bar and the System screen will appear as illustrated below:

![System Administration Screen](image)

Click on **“Home”** to return to Home Screen
Camera Name:
This field is used for entering a descriptive name for the device.

The default setting for the Camera Name is CS-xxxxxx, where xxxxxx is the last six digit of the MAC Address. The maximum length is 32 (Printable ASCII).

Location:
This field is used for entering a descriptive name for the location used by DCS-1000.

Admin:
This field is used for entering the Administrator ID along with the password to access the System Administration settings. Be sure to enter the password twice to confirm the details once in the Admin Password field and again in the Confirm Password field.

The default setting for Admin is blank space (Null String) you need to key in the Admin ID with a maximum length of 12 (Printable ASCII) characters and enter the Admin Password with a maximum length of 8 (Printable ASCII) characters.

It is highly recommended to set the Admin ID and Admin Password as soon as possible to enable security option for DCS-1000 to function.

IP Assignment:

<table>
<thead>
<tr>
<th>Important Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access to DCS-1000 is done through assigning a proper IP address. Please make sure to use a vacant IP address when you assign the IP address for DCS-1000. This will prevent errors from occurring if the IP address is overlapped.</td>
</tr>
</tbody>
</table>

There are two options to select from the IP Assignment either Manually Assign or Assign Automatically Using.

Manually Assign
You can click “Manually Assign” and directly enter the IP address.
The default settings are as follows:

- Default IP – 192.168.0.20
- Subnet Mask – 255.255.255.0
- Default Gateway – 0.0.0.0

**Assign Automatically Using**

If your network is using RARP, BOOTP or DHCP server you can click “Assign Automatically Using” and click on “RARP”, “BOOTP” or “DHCP”. Under this setting DCS-1000 will automatically assign an IP address from RARP, BOOTP or DHCP server. Each time the DCS-1000 starts up be sure the RARP, BOOTP or DHCP server is setup as assign a static IP to your DCS-1000.

If your application requires direct connection from an ADSL modem through DCS-1000’s RJ-45 LAN port and you also have an ISP PPPoE account. Click on “PPPoE” option and enter the Service Name, User ID and Password into the respective fields.

DCS-1000 will get an IP address from the ISP each time DCS-1000 starts up.

**DNS IP Address:**

DNS (Domain Name System) server is an Internet service that translates domain names (ie. www.dlink.com) into IP addresses (ie. 192.168.0.20). The DNS IP address can be received from your ISP. Enter at least one DNS IP Address.

**LED Control:**
The LED control allows user to setup the LED illumination as desired. This feature provides the flexibility when surveillance activity is ON.

There are three options as follows:

- Normal –
  - **Power** - Steady On of the LED indicator.
  - **LAN** - Steady On of the LED indicator. When LAN activity is present the LED indicator will flash steadily.

- OFF –
  - **Power** - LED indicator is off
  - **LAN** – LED indicator is off

- Dummy –
**Power** - Steady On of the LED indicator.

**LAN** - Steady On of the LED indicator with random flashing.

The default setting for the LED control is at Normal. When you have configured the LED control the correct illumination will set in after 1 minute.

**Note:**
This function is built-in to the LED indicators to add extra capabilities. The three options allow the Administrator to configure and camouflage the illumination for the LED indicator to falsify the monitoring status. In Normal Mode the LED indicator functions as normally. Under Off Mode the LED indicators are both off however, it is still monitoring the activity. In Dummy Mode the LED indicators operate in monitoring condition but monitoring activity is off or on.

**Loading ActiveX From:**
This field is used to specify the location of Xplug Control (ActiveX) plug-in program. Enter the information as required in .ocx format, for example: http://www.<your company>.com/xplug.ocx where <your company> must be replaced with your company’s DNS server.

**Open Second Port:**
The Web Server field allows settings to open a second port for DCS-1000. This will permit users IP Sharing Gateways to support multiple DCS-1000s. By default Port 80 is always opened for DCS-1000 Web Server access. Select “Yes” and input the second port value.

For example: If you have 5 Internet Cameras to be installed, each with an IP address from

192.168.0.101
192.168.0.102
192.168.0.103
192.168.0.104
192.168.0.105

You can open the second port for each Internet Camera from port 81 to Port 85 as illustrated below:

DCS-1000 1 – IP 192.168.0.101, second web port 81

16
DCS-1000 2 – IP 192.168.0.102, second web port 82
DCS-1000 3 – IP 192.168.0.103, second web port 83
DCS-1000 4 – IP 192.168.0.104, second web port 84
DCS-1000 5 – IP 192.168.0.105, second web port 85

You also need to setup your DSL gateway for Port Mapping.

Port 81 map to 192.168.0.101
Port 82 map to 192.168.0.102
Port 83 map to 192.168.0.103
Port 84 map to 192.168.0.104
Port 85 map to 192.168.0.105

The Transfer Image field allows settings to open a second port for DCS-1000 to transfer images. The default Port 8481 is open image transfer and you can define a second port similar to the above.

Save/Cancel:
After making sure all settings in the System are correct, click on the “Save” icon to store the settings for DCS-1000. You can alternatively click on the “Cancel” icon to restore all settings to the values last saved to or retrieved from DCS-1000.
System Administration - Image
Image menu in the system administration contains commands to provide the settings for the images captured by DCS-1000.

Click on “Image” in the system administration menu bar and the Image screen will appear as illustrated below:

Video Resolution:
Select the desired video resolution format ranging from 160x120, 320x240 (default) or 640x480

Compression Rate:
Select the desired compression rate with five levels from very low to very high. Higher video compression rate will generate more compact file size with less video quality and vise-versa. The default setting is at Medium.

Frame Rate:
Select the frame rate desired with default setting at Auto for optimal frame rate.

Brightness Control:
Adjust the brightness level with default setting at 64.

Contrast Control:
Adjust the contrast level with default setting at 64.
**Hue Control:**
Adjust the hue level with default setting at 64.

**Light Frequency:**
Adjust the light frequency to suit your area of operation from the options either 50 Hz or 60 Hz (default).

**Note:**
50 Hz and 60 Hz variants are available to accommodate the different light frequency found in USA (60 Hz) and Europe (50 Hz) for the DCS-1000 to ensure better image quality.

**Save/Cancel:**
After making sure all settings in the Image are correct, click on the “Save” icon to store the settings for DCS-1000. You can alternatively click on the “Cancel” icon to restore all settings to the values last saved to or retrieved from DCS-1000.

**System Administration - Users**
The User options menu contains commands to allow system administrator to assign legal users who are permitted to monitor DCS-1000 from the remote site.

Click on “Users” in the system administration menu bar and the Users screen will appear as illustrated below:

![User Screen](image)

**Add User:**
**User Name:**
Enter the user name in this field.

Click on “Home” to return to Home Screen
A maximum of 64 users names are allowed, however each users name must be different. Each user name can be used as a group given the password for example, if the User Name is “Guest” and the User Password is “Guest” anyone can access DCS-1000 with these details used as a group of users under the User Name Guest. The maximum length for the User Name is 12 (Printable ASCII).

User Password:
Enter the user’s password assigned by the administrator. The maximum password length is 8 (Printable ASCII).

I/O Output Control:
Administrator has the authority to give permission for the privilege to control the I/O Output Control to user’s by selecting “Yes” or “No” to activate the I/O Output control.

To add a new users name input the necessary information first and click on the “Add” icon.

Delete User:
Select the user you wish to delete from the pull down menu and click on the “delete” icon.

Important Information
Once administrator has configured DCS-1000 Users, any user will be required to enter a login password to access the video image from DCS-1000. The password dialog box is illustrated below.
System Administration – DateTime
The DateTime menu contains commands for setting DCS-1000's time and date requirements to provide correct information to users who might be thousands of miles away in the remote site. There are two options to select from the DateTime menu bar either Synchronized with Time Server or Set Manually.

Click on “DateTime” in the system administration menu bar and the DateTime screen will appear as illustrated below:

DateTime:
Select “Synchronized with Time Server” and the time will be based on GMT setting. The time will be synchronized every 10 minutes. This is also the default setting for DCS-1000.

IP Address:
Enter the IP Address of the Time Server in this field.

Protocol:
Two options of NTP or Time are available for your selection to link with the Time Server. The default setting is NTP.

TimeZone:
System administrator must select the time zone for the region. Please refer to the appendix for the time zone selection table.
To set the Date Time manually select “Set Manually”. The system administrator must then enter the Date and Time in the respective field manually.

When you select “Set Manually”, each time the DCS-1000W is powered off and on you must re-enter the details once again due to time lost.

**Note 1:**
Please find below NTP server web address for your reference to set the time server.

- http://www.eecis.udel.edu/~mills/ntp/clock1.htm
- http://www.eecis.udel.edu/~mills/ntp/clock2.htm

**Note 2:**
When you select Set Manually, each time DCS-1000 is powered off and on you must re-enter the details once again due to time lost.

**Save/Cancel:**
After making sure all settings in the DateTime are correct, click on the “Save” icon to store the settings for DCS-1000. You can alternatively click on the “Cancel” icon to restore all settings to the values last saved to or retrieved from DCS-1000.
System Administration – Trigger
The Trigger menu contains commands for the I/O Trigger connectors providing the physical interface for 2 digital output and 2 digital input that is used for connecting a diversity of external alarm devices to DCS-1000 such as IR-Sensor and alarm relay.

Click on “Trigger” in the system administration menu bar and the Trigger screen will appear as illustrated below:

![Trigger Screen](image)

Click on “Home” to return to Home Screen

The default setting for the I/O Trigger functions are disabled you must enable the I/O Trigger first before the Triggers will perform.

There are two options to select from the Trigger screen: I/O Input 1 Trigger and I/O Input 2 Trigger.

I/O Input 1 Trigger:
Select “Send e-mail attached with image” and enter the relevant information such as the SMTP Server Address, Sender e-mail Address, Receiver e-mail Address, Sending Interval, and Sending Times.
- **SMTP** (Simple Mail Transfer Protocol) is a protocol for sending e-mail messages between servers you need to input the mail server address in this field.
- **Sender e-mail** is the person’s e-mail address whom will be sending the e-mail.
- **Receiver e-mail** is the e-mail address of the person whom will receive the e-mail.
- **Sending Interval** is the period of time between each e-mail being sent to the receiver. If the setting is at 10 seconds, a new e-mail will be sent in 10 seconds interval to the receiver.
- **Sending Time** is the number of times the e-mail will be sent to the receiver before it terminates.

Select **“Trigger I/O Output”** and enter the setting for the duration of the output device for Output 1 time and Output 2 time in seconds.

**I/O Input 2 Trigger:**
Select **“Send e-mail attached with image”** and enter the relevant information such as the SMTP Server Address, Sender e-mail Address, Receiver e-mail Address, Sending Interval and Sending Times.

- **SMTP** (Simple Mail Transfer Protocol) is a protocol for sending e-mail messages between servers you need to input the mail server address in this field.
- **Sender e-mail** is the person’s e-mail address whom will be sending the e-mail.
- **Receiver e-mail** is the e-mail address of the person whom will receive the e-mail.
- **Sending Interval** is the period of time between each e-mail being sent to the receiver. If the setting is at 10 seconds, a new e-mail will be sent in 10 seconds interval to the receiver.
- **Sending Time** is the number of times the e-mail will be sent to the receiver before it terminates.

Select **“Trigger I/O Output”** and enter the setting for the duration of the output device for Output 1 time and Output 2 time in seconds.

**Save/Cancel:**
After making sure all settings in the System are correct, click on the **“Save”** icon to store the settings for the DCS-1000. You can alternatively click on the
“Cancel” icon to restore all settings to the values last saved to or retrieved from DCS-1000.

Warning

When connecting other devices through the I/O connectors, please make sure the maximum current of 100mA is strictly observed. Any failure to do so might cause a loss of power to DCS-1000 and possibly cause serious damage to the Network Camera.

Please refer to the appendix for detailed information regarding the I/O Connector.
System Administration - Information
The Information menu contains commands for displaying information about DCS-1000.

Click on “Information” in the system administration menu bar and the Information screen will appear as illustrated below:

The Information table provides detailed information of DCS-1000 such as the Model Name, Firmware Version, Mac Address, and IP Address.

System Administration - Tools
The Tools menu contains commands for restarting DCS-1000.

Click on “Tools” in the system administration menu bar and the Tools screen will appear as illustrated below:

Reset:
The Reset command restarts DCS-1000 just like turning the device off and on and saved settings are retained. The Reset panel contains the message “Do you really want to reset this device?” and a YES button. If you do not want to reset DCS-1000, exit the panel without clicking YES, otherwise, click on the “YES” icon and the reset process will initiate.
**Factory Reset:**
A factory reset restarts DCS-1000 and returns all of its settings to their default values. The Factory Reset panel contains the message “Do you really want to factory reset this device?” and a YES button. If you do not want to carry out a factory reset command, exit the panel without clicking YES, otherwise click on the “YES” icon and factory reset will be initiated.

**Note:**
The Network must be reconfigured after a Factory Reset.

Once the configuration is completed click on “Home” to return to the Home screen and select the desired Viewing Image either through ActiveX Mode or Java Mode as described in the next section.

Then position DCS-1000 to the desired location appropriately for your purpose. Followed by adjustment of DCS-1000 focus, done manually by turning the lens clockwise or anti-clockwise to the desire image quality. *Please refer to the appendix for detailed information regarding Adjusting DCS-1000 Focus and Replacing the Lens.*

**View Image – ActiveX Mode**

To view video images from the browser, click on “View Image – ActiveX Mode” from the Home screen to access the video images from Internet Explorer as illustrated below:
**Camera Name** - The Camera name will be display when the Camera Name field is entered in the Web Configuration setting under **“System”**

**Location** - The location of DCS-1000W will be displayed when the Location field is entered in the Web Configuration settings under **“System”**.

**Note:**
*Please refer to the appendix on how to install ActiveX.*
1. Install to the Web Server
2. Install to your Local PC

In the View Image – ActiveX Mode you are allowed two output trigger options. Just click on the desired selection **“ON”** or **“OFF”** to utilize the options for each of the output triggers (Output 1 trigger or Output 2 trigger).

**Note 1:**
Output trigger will send a 5V signal to the device connected to the DCS-1000. A maximum of two devices is permitted to connect to DCS-1000 to utilize the output trigger function. *Please refer to appendix for detailed information.*

**Note 2:**
Administrator has the authority to allow user’s the permission to set the output trigger functions through the setting in the **“Users”** of System Administration menu bar.
View Image – Java Mode
Click on “View Image – Java Mode” from the Home screen to access the video images from the Internet Explorer or Netscape browser as illustrated below:

Camera Name* - The Camera name will be display when the Camera Name field is entered in the Web Configuration setting under “System”
Location** - The location of DCS-1000W will be displayed when the Location field is entered in the Web Configuration settings under “System”.

In the View Image – Java Mode you are allowed two output triggers. Just click on the desired selection “ON” or “OFF” to utilize the options for each of the output triggers (Output 1 trigger or Output 2 trigger).

Note 1:
Output trigger will send a 5V signal to the device connected to DCS-1000. A maximum of two devices is permitted to connect to DCS-1000 to utilize the output trigger function. *Please refer to appendix for detailed information.*

Note 2:
Administrator has the authority to allow user’s the permission to set the output trigger functions through the setting in the “Users” of System Administration menu bar.
IPView Application Installation

Installation
Insert the CD-ROM into the CD-ROM drive to initiate the auto-run program. Once completed a menu screen will appear as follows:

To install the IPView Application click on the "IPView" button to activate the installation procedure for the application program.

Once executed a prompt will appear requesting the input of the desired language selection. Make the desired selection and click on “OK” to continue.
The Welcome screen will appear. Click on the “Next” button to proceed with the installation.

![InstallShield Wizard](image)

The License Agreement prompt will appear as below. Read the details carefully and click on the “Yes” icon to continue with the installation procedure.
A prompt will appear and in the Destination Location dialog box, you may click on “Next” to accept the recommended destination location or click on “Browse” to select another location. After specifying the desired destination location, click on “Next” to proceed further.

![Destination Location Prompt]

The Select Program Folder prompt will appear providing information of where the IPView application will be located, click on “Next” to continue. If you wish to modify your settings, click on “Back” to return to the previous screens.

![Select Program Folder Prompt]

Please wait until one of the two dialog box to appear, select either “Yes, I want to restart my computer now” and click on the “Finish” icon to restart the computer to complete the installation procedure.
or click on the “Finish” icon to complete the installation procedure

After successfully installing the IPView, the application program for DCS-1000 is automatically installed to \Programs\Files Directory.

To start running the IPView click on windows Start Menu/Programs/IPView/IPView
Once IPView is executed a Login prompt will appear, you must enter the default User Name: “admin” into the respective field and click on “OK” to log into the application.

Once login, the IPView application is executed and the IPView interface will appear as follows in the default List View format:
IPView – Getting Started

This section describes the operation of the IPView application User Interface with detailed procedures for using the application.

**IPView**

IPView is responsible for the management of preview, configuration, and searching of each camera.

It is designed with a user-friendly interface for ease of control and navigation requirements as illustrated below.
How to Change Password
Change Password

When IPView is used for the first time it is highly recommended to change the User Name and Password by the Administrator to constrain users access to the IPView application. Once the User Name and Password are defined only the Administrator has access to the management of IPView applications. This procedure should be done as soon as possible to prevent unauthorized usage of IPView application.

Once IPView is executed a Login prompt will appear, you must enter the default User Name: admin into the respective field and click on “OK” to log into the application.
To change the **User Name** and **Password** select “Tools” > “Options”. The **Options** dialog box will appear as illustrated below.

The administrator needs to enter a **User Name**, **Password** and **Confirm** password into the respective fields. Once all the new details are entered click on the “**OK**” icon.

Make sure to save any changes you have made to keep the information updated.

**Note:**
Alternatively you can click the **Options** icon as illustrated or use the hot key “**F10**”.
How to Change IP Address

Change IP Address

To change an IP Address for a camera select “Camera” > “Add”. An Add Camera dialog box will appear as illustrated below.

Click on the “Browse” icon, the Browse Camera dialog box will appear with a blank screen as illustrated below.

Click on the “Search” icon and IPView will detect and search all the available camera’s that are installed on the local area network as depicted below:
You must highlight the camera you wish to change the IP Address and click on the “Change IP” icon and the Change IP Address dialog box will appear as depicted below:

Enter the new IP Address along with the Subnet Mask and Default gateway into the respective fields and click on the “OK” icon and IPView will automatically change the IP Address.

Make sure to save any changes you have made to keep the information updated.
How to Add a Camera

Add Camera

To add a new camera select “Camera” > “Add”. An Add Camera dialog box will appear as illustrated below.

You can enter the IP Address of the camera in the specified field and click the “Add” icon to add a new camera. If the IP Address is entered incorrectly a dialog box will appear to notify the error.

If you are unsure of the IP Address of the camera you can click on the “Browse” icon, the Browse Camera dialog box will appear with a blank screen as illustrated below.
Click on the “Search” icon and IPView will detect and search all the available camera’s that are installed on the local area network as depicted below:

You must highlight the camera you wish to add and click on the “Add” icon. The Add Camera dialog box will appear once again with the IP Address entered. Click on the “Add” icon and the camera will be automatically added into IPView list view format.

Alternatively you can double click on the camera you wish to add and the Add Camera dialog box will appear once again with the IP Address entered. Click on the “Add” icon and the camera will be automatically added into IPView list view format.
If the **Login Camera** dialog box appears make sure to enter the correct **User Name** and **Password** and click on the “**OK**” icon and the camera will be added into IPView in list format. If the **User Name** and **Password** is entered incorrectly the camera will not be added into IPView.

The above dialog box will appear only if administrator has already set the **User Name** and **Password** during the Web Configuration setting.

If you forget to highlight the camera you wish to add a dialog box will appear to notify you of the error.

Make sure to save any changes you have made to keep the information updated.

**Note 1:**  
You are only able to add one camera at a time.

**Note 2:**  
Alternatively you can click the **Add** icon as illustrated or use the hot key “**Shift+Ins**”.
How to Delete a Camera

Delete Camera

To delete a camera you must highlight the camera you wish to delete from IPView list view format. From the menu bar select “Camera” > “Delete”. A Delete Camera dialog box will appear and click on the “Yes” icon to delete the camera or click on “No” if you do not wish to delete the camera as illustrated below.

Make sure to save any changes you have made to keep the information updated.

Note:
Alternatively you can click the Delete icon as illustrated or use the hot key “Del”.
How to View a Camera

View Camera

From the menu bar select “View” > “4 Cameras” (other choices are available in 1 Camera, 9 Cameras and 16 Cameras viewing format) and the viewing screen will appear with the video image.

Note:
The icon on the upper left corner of the screen will appear with the camera number that is being displayed.

To return to the IPView list view format, click on the icon located on the upper left corner of the screen and a case sensitive menu will appear. Select “List” and the viewing image will return to the list view format.

Note 1:
A maximum of 16 cameras are available for viewing with the IPView application.

Note 2:
Alternatively you can click the 1 Camera icon as illustrated or use the hot key “Ctrl+F3”. For 4 Cameras, 9 Cameras and 16 Cameras click the respective icon or use the hot key as follows “Ctrl+F4”, “Ctrl+F5” and “Ctrl+F6”. To return to list view format use the hot key “Ctrl+F1”.

44
How to Snap shot a Camera

Snap shot Camera

To snap shot a camera you must highlight the camera you wish to snap shot from the list view format. From the menu bar select “Camera” > “Snap shot”. A Save Image dialog box will appear for you to save the snap shot picture.

A second alternative is from the viewing mode either 1, 4, 9, 16 cameras click on the icon located on the upper left corner of the screen and a case sensitive menu will appear and select the “Snap shot” icon. A Save Image dialog box will appear for you to save the snap shot picture.

Note:
Alternatively you can click the Snap shot icon as illustrated or use the hot key “F5”.

How to Adjust the Property Setting

Property Setting

“Property” is initiated by selecting “Camera” > “Property” and a dialog box will appear allowing settings of Web Configuration and upgrade firmware (Please refer to the appendix for detailed information). The Camera Property dialog box will appear for you to select the desired options from the tab selections to Configure the camera as shown below.

General
Allows settings for the camera name, location and administrator information such as administrator ID and password. Please refer to the Web Configuration section under “System Administration – System” for further details.
**IP Assignment**
There are two options to select from the IP Assignment either *Manually Assign* or *Assign Automatically Using*. Please refer to the Web Configuration section under “System Administration – System” for further details.

**DNS**
DNS (Domain Name System) server is an Internet service that translates domain names into IP addresses. Enter at least one DNS IP Address. Please refer to the Web Configuration section under “System Administration – System” for further details.
**Wireless**
(Please skip this section if your camera is not wireless)

Allows setting for connection mode, network name, wireless channel, and WEP key. Please refer to the Web Configuration section under “**System Administration – System**” for further details.

**Misc**
Allows setting for LED Control, ActiveX control location, and second port. Please refer to the Web Configuration section under “**System Administration – System**” for further details.
**Image**
Image provides the settings for the video image of the camera such as brightness, contrast, hue, resolution, compression, frame rate, and light freq. Please refer to the Web Configuration section under “System Administration – Image” for further details.

**Users**
Contain commands to allow system administrator to assign legal users who are permitted to monitor the camera from the remote site by **Add** or **Delete** user.
To add a user click on the **“Add”** icon and the **Add User** dialog box will appear. Enter the User Name and Password into the specific field. Select the I/O Output Control to give users the privilege of accessing the I/O Output Control.

To delete a user, select the user and click on the **“Delete”** icon.

Please refer to the Web Configuration section under **“System Administration – Users”** for further details.

**Date/Time**
Contain commands for setting the camera’s time and date to provide correct time information to users who might be thousands of miles away in the remote site by selecting **Synchronized with Time Server** or **Set Manually**. Please refer to the Web Configuration section under **“System Administration – TimeDate”** for further details.
Trigger 1

Contains commands for setting the I/O Trigger connectors providing the physical interface for 1 digital output and 1 digital input that is used for connecting a diversity of external alarm devices to the camera such as IR-Sensor and alarm relay. Please refer to the Web Configuration section under “System Administration – Trigger” for further details.
Trigger 2

Contains commands for setting the I/O Trigger connectors providing the physical interface for 1 digital output and 1 digital input that is used for connecting a diversity of external alarm devices to the camera such as IR-Sensor and alarm relay. Please refer to the Web Configuration section under “System Administration – Trigger” for further details.

Information

Displays information about the camera such as the model, firmware version, MAC address, and IP address. Please refer to the Web Configuration section under “System Administration – Information” for further details.
**Tools**

Contains commands to reset the camera and update firmware (please refer to the appendix for detailed information). Please refer to the Web Configuration section under “**System Administration – Tools**” for further details on reset.

Make sure to save any changes you have made to keep the information updated.
Note:
Alternatively you can click the Property icon as illustrated or use the hot key “F2”.

Menu Bar
The menu bar provides easier access for users to navigate the IPView with different selections along with hot key capabilities as follows:

Menu Bar - File
“File” on the menu bar provides “New”, “Open”, “Save”, “Save As” and “Exit” for users to create new files, open existing files, save files, and exit the IPView as depicted below.

Menu Bar – View
“View” on the menu bar provide users with management capabilities for “Columns”, “List”, “Camera” and “Refresh”. You can view Camera in “1 Camera”, “4 Cameras”, “9 Cameras”, “16 Cameras”. The “View” menu bar is pictured below.
Columns

When “Columns” is launched a dialog box will appear allowing the option to choose the columns one would like to display in List View as illustrated below.

Viewing Format

You can view the format in “List” view. The “List” viewing format allows easy management and control of each camera.

List View

“List” view is illustrated below for your reference. You are able to list all the cameras and their properties such as the camera name, IP address, user name, and location will be displayed for ease of control and management.
Note:
Right click the mouse pad on any kind of the camera will bring up a context sensitive menu which shows the actions you can apply to the selected camera.

Double click on the desired camera will bring up the Property dialog box.

To update camera list view just click on the “Refresh” icon for Real Time Data and the latest information.

Menu Bar - Camera

“Camera” on the menu bar provides options to manage the camera. One can “Add” additional Camera with a maximum of 16 Camera allowed for viewing. Through the management function one can “Delete” a camera, manage the “Property”, “Enable” for real time and take a “Snap shot” image. The menu bar is illustrated below:
Enable Function

By default the video image is enabled. There will be a “check” next to the Enable command to show that the Enable function is working. To disable real-time image select “Camera” > “Enable” and real-time video image will stop and shutdown.

Menu Bar - Tools

"Tools" on the menu bar allows administrator management of the security settings such as User Name and Password to gain access into the IPView application. From the menu bar select "Tools” > "Options" and a dialog box will appear. Administrator can change the User Name and Password for security settings to access the application.

Menu Bar - Help

“Help” on the menu bar provides “Contents” and “About” to instruct users how to operate the camera in HTLM format. From the menu bar select “Help” and can choose either “Contents” or “About” as depicted below:
IPView Icon Description

- Open a new file. Alternatively the hot key is Ctrl+N.
- Open an existing file. Alternatively the hot key is Ctrl+O.
- Save a file. Alternatively the hot key is Ctrl+S.
- List view format. Alternatively the hot key is Ctrl+F1.
- 1 Camera view format. Alternatively the hot key is Ctrl+F3.
- 4 Camera view format. Alternatively the hot key is Ctrl+F4.
- 9 Camera view format. Alternatively the hot key is Ctrl+F5.
- 16 Camera view format. Alternatively the hot key is Ctrl+F6.
- Refresh IPView application. Alternatively the hot key is F12.
- Add a camera. Alternatively the hot key is Shift+Ins.
- Delete a camera. Alternatively the hot key is Del
- Property setting to configure the camera. Alternatively the hot key is F2.
- Snap shot to capture a single still image. Alternatively the hot key is F5.
- Options to modify the User Name and Password for IPView. Alternatively the hot key is F10.
Context Sensitive Menu

In list view format by highlighting a camera and right clicking the mouse pad will bring up a context sensitive menu for features such as “Add”, “Delete”, “Property”, “Enable”, and “Snap shot”.

![Context Sensitive Menu Screen Capture](image-url)
In view mode format click on the icon located on the upper left corner of the screen and a case sensitive menu will appear as illustrated below.

Features such as “Enable”, “Snap shot”, “List”, “1 Camera”, “4 Cameras”, “9 Cameras”, “16 Cameras”, “Previous Page” and “Next Page” will be available.
Uninstall IPView Application

Click on windows **Start Menu / Settings / Control Pane** l. A prompt screen will be displayed like the one below and double click on the **Add/Remove Programs** icon.
From the Add/Remove Programs Properties Menu, select “IPView” as illustrated below.

Then click on the “Remove” button. A new prompt screen will be displayed like the one below confirming the removal.

Click on the “OK” icon to continue the process or click on the “Cancel” icon to reject the uninstall process.
The InstallShield Wizard prompt will appear and click on **“Finish”** to complete the uninstallation procedure.
Appendix

Frequently Asked Questions

Internet Camera Features

Q:  What is a Internet Camera?
A:  DCS-1000 is a standalone system connecting directly to an Ethernet or Fast Ethernet network. It is different from the conventional PC Camera, the DCS-1000 is an all-in-one system with built-in CPU and web-based solutions providing a low cost solution that can transmit high quality video images for monitoring. The DCS-1000 can be managed remotely, accessed and controlled from any PC/Notebook over the Intranet or Internet via a web browser.

Q:  What is the maximum number of users that can be allowed to access DCS-1000 simultaneously?
A:  Maximum number of users that can log onto DCS-1000 at the same time is 64. Please keep in mind the overall performance of the transmission speed will slow down when many users are logged on.

Q:  What algorithm is used to compress the digital image?
A:  DCS-1000 utilizes the JPEG image compression technology providing high quality images for users. JPEG is adopted since it is a standard for image compression and can be applied to various web browser and application software without the need to install extra software.

Q:  Can I capture and record images from DCS-1000?
A:  Yes you are able to capture images both snapshot of a single image or video image from the IPView application supplied with DCS-1000 CD-ROM. Please refer to the User’s Guide for detailed information.

Internet Camera Installation

Q:  Can the Internet Camera be used out-doors?
A:  DCS-1000 is not weatherproof. It needs to be equipped with a weatherproof case to be used outdoors and it is not recommended.
**Q:** What network cabling is required for DCS-1000?
**A:** DCS-1000 uses Category 5 UTP cable allowing 10 Base-T and 100 Base-T networking.

**Q:** Can DCS-1000 be setup as a PC-cam on the computer?
**A:** No, DCS-1000 is an Internet Camera used only on Ethernet and Fast Ethernet network.

**Q:** Can DCS-1000 be connected on the network if it consists of only private IP addresses?
**A:** DCS-1000 can be connected to LAN with private IP addresses.

**Q:** Can DCS-1000 be installed and work if a firewall exists on the network?
**A:** If a firewall exists on the network, port 80 is open for ordinary data communication. However, since DCS-1000 transmits image data, the default port 8481 is also required. Therefore, it is necessary to open port 8481 of the network for remote users to access DCS-1000.
PING Your IP Address

The PING (Packet Internet Groper) command can determine whether a specific IP address is accessible by sending a packet to the specific address and waiting for a reply. It can also provide a very useful tool to confirm if the IP address conflicts with DCS-1000 over the network.

Follow the step-by-step procedure below to utilize the PING command but first you must disconnect DCS-1000 from the network.

Start a DOS window.
Type ping x.x.x.x, where x.x.x.x is the IP address of the DCS-1000.

The succeeding replies as illustrated below will provide useful explanation to the cause of the problem with DCS-1000 IP address.
Trouble Shooting

Q: I cannot access DCS-1000 from a web browser?
A1: The possible cause might be the IP Address for the DCS-1000 is already being used by another device. To correct the possible problem, you need to first disconnect DCS-1000 from the network. Then run the PING utility (follow the instructions in Appendix B - PING Your IP Address).

A2: Another possible reason is the IP Address is located on a different subnet. To fix the problem, run the PING utility (follow the instructions in Appendix B - PING Your IP Address). If the utility returns “no response” or similar, the finding is probably correct, then you should proceed as follows:-

In Windows 95/98/2000 and Windows NT, double check the IP Address of the DCS-1000 is within the same subnet as your workstation.

Click “Start”, “Setting”, “Control Panel”, and the “Network” icon. Select TCP/IP from the “Network” dialog box and from the “TCP/IP Properties” dialog box click on “Specify an IP address”. If the DCS-1000 is situated on a different subnet than your workstation, you will not be able to set the IP address from this workstation. To verify make sure the first 3 sections of the IP address of the DCS-1000 corresponds to the first 3 sections of the workstation. Therefore the IP address of the DCS-1000 must be set from a workstation on the same subnet.

A3: Other possible problems might be due to the network cable. Try replacing your network cable. Test the network interface of the product by connecting a local computer to the unit, utilizing a standard Crossover (hub to hub) Cable. If the problem is not solved the DCS-1000 might be faulty.

Q: Why does the Power LED not light up constantly?
A: The power supply used might be at fault. Confirm that you are using the provided power supply DC 5V for the DCS-1000 and verify that the power supply is well connected.

Q: Why does the LAN LED not light up properly?
A1: There might be a problem with the network cable. To confirm that the cables are working, PING the address of a known device on the network. If the
cabling is OK and your network is reachable, you should receive a reply
similar to the following (.bytes = 32 time = 2 ms).

A2: The network device utilized by the DCS-1000 is not functioning properly
such as hubs or switches. Confirm the power for the devices are well
connected and functioning.

Q: Why does the DCS-1000 work locally but not externally?
A1: Might be caused from the firewall protection. Need to check the Internet
firewall with your system administrator.

A2: The default router setting might be a possible reason. Need to double
check if the configuration of the default router settings is required.

Q: Why does a series of broad vertical white line appears through out the
image?
A: A likely issue is that the CMOS sensor becomes overloaded when the light
source is too bright such as direct exposure to sunlight or halogen light. You
need to reposition the DCS-1000 into a more shaded area immediately as this
will damage the CMOS sensor.

Q: There is bad focus on the DCS-1000, what should be done?
A1: The focus might not be correctly adjusted for the line of sight. You need
to adjust the DCS-1000 focus manually as described in Adjust Internet
Camera Focus.

A2: There is no adaptor fitted with your C-type lens. If you have previously
changed the supplied CS-type lens, you may have unintentionally installed a
C-type lens without fitting the adaptor first.

Q: Noisy images occur how can I solve the problem?
A1: The video images might be noisy if the DCS-1000 is used is a very low
light environment. To solve this issue you need more lighting.

Q: There is poor image quality, how can I improve the image?
A1: A probable cause might be the incorrect display properties configuration
for your desktop. You need to open the Display Properties on your desktop
and configure your display to show at least 65’000 colors for example at least
16-bit.
Note:
Applying only 16 or 256 colors on your computer will produce dithering artifacts in the image.

A2: The configuration on the DCS-1000 image display is incorrect. Through the Web Configuration Image section you need to adjust the image related parameter for improve images such as brightness, contrast, hue and light frequency. Please refer to the Web Configuration section for detail information.

Q: There are no images available through the web browser?
A: The ActiveX might be disabled. If you are viewing the images from Internet Explorer make sure ActiveX has been enabled in the Internet Options menu. Alternatively, you can use the Java Applet for viewing the required images.
I/O Connector

I/O Connector Definition for DCS-1000

An 8-pole connector is provided for auxiliary IO connections to the DCS-1000.

The IO connector provides the physical interface for 2 digital output and 2
digital input that is used for connecting a diversity of external alarm devices to
the DCS-1000 such as IR-Sensor and alarm relay.

The digital input is used for connecting external alarm devices and once
triggered images will be taken and e-mailed.

The supported transistor output can give a maximum of DC 5V to the
externally connected alarm devices and once triggered the current will activate
the devices.

<table>
<thead>
<tr>
<th>In 11</th>
<th>In 11 &amp; In 12 is a pair for digital input. It works at voltage 5V</th>
</tr>
</thead>
<tbody>
<tr>
<td>In 12</td>
<td></td>
</tr>
<tr>
<td>In 21</td>
<td>In 21 &amp; In 22 is a pair for digital input. It works at voltage 5V</td>
</tr>
<tr>
<td>In 22</td>
<td></td>
</tr>
<tr>
<td>Out 1 +</td>
<td>Out 1 + &amp; Out 2 + is a pair for digital out. The output voltage is 5V and maximum current is 100 mA</td>
</tr>
<tr>
<td>Out 1 -</td>
<td></td>
</tr>
<tr>
<td>Out 2 +</td>
<td>Out 2 - &amp; Out 2 - is a pair for digital out. The output voltage is 5V and maximum current is 100 mA</td>
</tr>
<tr>
<td>Out 2 -</td>
<td></td>
</tr>
</tbody>
</table>
Note:

Through the Web Configuration in the Trigger section, you must first enable the trigger function. Please refer to the Web Configuration section for detailed information.
Upgrade Firmware

User’s can update firmware from the IPView application. Select “Camera” > “Properties” and the Camera Property dialog box will appear. Select the Tools tab and enter the full path of the firmware binary file name in the Update Firmware field or you can click on the “Browse” icon to select the file. Once the firmware file is entered click on the “Update” icon to proceed with the updating process. Once completed click on the “OK” icon as illustrated below

![Camera Property dialog box]

Warning
The download firmware procedure cannot be interrupted. If the network connection is broken during the download procedure it might possibly cause serious damage to the Internet Camera.
## Time Zone Table

<table>
<thead>
<tr>
<th>Time Zone</th>
<th>City, Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>(GMT-12:00)</td>
<td>Eniwetok, Kwajalein</td>
</tr>
<tr>
<td>(GMT-11:00)</td>
<td>Midway Island, Samoa</td>
</tr>
<tr>
<td>(GMT-10:00)</td>
<td>Hawaii</td>
</tr>
<tr>
<td>(GMT-09:00)</td>
<td>Alaska</td>
</tr>
<tr>
<td>(GMT-08:00)</td>
<td>Pacific Time (US &amp; Canada); Tijuana</td>
</tr>
<tr>
<td>(GMT-07:00)</td>
<td>Arizona</td>
</tr>
<tr>
<td>(GMT-07:00)</td>
<td>Mountain Time (US &amp; Canada)</td>
</tr>
<tr>
<td>(GMT-06:00)</td>
<td>Central Time (US &amp; Canada)</td>
</tr>
<tr>
<td>(GMT-06:00)</td>
<td>Mexico City, Tegucigalpa</td>
</tr>
<tr>
<td>(GMT-06:00)</td>
<td>Saskatchewan</td>
</tr>
<tr>
<td>(GMT-05:00)</td>
<td>Bogota, Lima, Quito</td>
</tr>
<tr>
<td>(GMT-05:00)</td>
<td>Eastern Time (US &amp; Canada)</td>
</tr>
<tr>
<td>(GMT-05:00)</td>
<td>Indiana (East)</td>
</tr>
<tr>
<td>(GMT-04:00)</td>
<td>Atlantic Time (Canada)</td>
</tr>
<tr>
<td>(GMT-04:00)</td>
<td>Caracas, La Paz</td>
</tr>
<tr>
<td>(GMT-04:00)</td>
<td>Santiago</td>
</tr>
<tr>
<td>(GMT-03:30)</td>
<td>Newfoundland</td>
</tr>
<tr>
<td>(GMT-03:00)</td>
<td>Brasilia</td>
</tr>
<tr>
<td>(GMT-03:00)</td>
<td>Buenos Aires, Georgetown</td>
</tr>
<tr>
<td>(GMT-02:00)</td>
<td>Mid-Atlantic</td>
</tr>
<tr>
<td>(GMT-01:00)</td>
<td>Azores, Cape Verde Is.</td>
</tr>
<tr>
<td>(GMT)</td>
<td>Casablanca, Monrovia</td>
</tr>
<tr>
<td>(GMT)</td>
<td>Greenwich Mean Time: Dublin, Edinburgh, Lisbon, London</td>
</tr>
<tr>
<td>(GMT+01:00)</td>
<td>Amsterdam, Berlin, Bern, Rome, Stockholm, Vienna</td>
</tr>
<tr>
<td>(GMT+01:00)</td>
<td>Belgrade, Bratislava, Budapest, Ljubljana, Prague</td>
</tr>
<tr>
<td>(GMT+01:00)</td>
<td>Brussels, Copenhagen, Madrid, Paris, Vilnius</td>
</tr>
<tr>
<td>(GMT+01:00)</td>
<td>Sarajevo, Skopje, Sofia, Warsaw, Zagreb</td>
</tr>
<tr>
<td>(GMT+02:00)</td>
<td>Athens, Istanbul, Minsk</td>
</tr>
<tr>
<td>(GMT+02:00)</td>
<td>Bucharest</td>
</tr>
<tr>
<td>(GMT+02:00)</td>
<td>Cairo</td>
</tr>
<tr>
<td>(GMT+02:00)</td>
<td>Harare, Pretoria</td>
</tr>
<tr>
<td>(GMT+02:00)</td>
<td>Helsinki, Riga, Tallinn</td>
</tr>
<tr>
<td>(GMT+02:00)</td>
<td>Jerusalem</td>
</tr>
<tr>
<td>(GMT+03:00)</td>
<td>Baghdad, Kuwait, Riyadh</td>
</tr>
<tr>
<td>(GMT+03:00)</td>
<td>Moscow, St. Petersburg, Volgograd</td>
</tr>
<tr>
<td>(GMT+03:00)</td>
<td>Nairobi</td>
</tr>
<tr>
<td>(GMT+03:30)</td>
<td>Tehran</td>
</tr>
<tr>
<td>(GMT+04:00)</td>
<td>Abu Dhabi, Muscat</td>
</tr>
<tr>
<td>(GMT+04:00)</td>
<td>Baku, Tbilisi</td>
</tr>
<tr>
<td>(GMT+04:30)</td>
<td>Kabul</td>
</tr>
<tr>
<td>(GMT+05:00)</td>
<td>Ekaterinburg</td>
</tr>
<tr>
<td>(GMT+05:00)</td>
<td>Islamabad, Karachi, Tashkent</td>
</tr>
<tr>
<td>(GMT+05:30)</td>
<td>Bombay, Calcutta, Madras, New Delhi</td>
</tr>
<tr>
<td>(GMT+06:00)</td>
<td>Astana, Almaty, Dhaka</td>
</tr>
<tr>
<td>(GMT+06:00)</td>
<td>Colombo</td>
</tr>
</tbody>
</table>
(GMT+07:00) Bangkok, Hanoi, Jakarta
(GMT+08:00) Beijing, Chongqing, Hong Kong, Urumqi
(GMT+08:00) Perth
(GMT+08:00) Singapore
(GMT+08:00) Taipei
(GMT+09:00) Osaka, Sapporo, Tokyo
(GMT+09:00) Seoul
(GMT+09:00) Yakutsk
(GMT+09:30) Adelaide
(GMT+09:30) Darwin
(GMT+10:00) Brisbane
(GMT+10:00) Canberra, Melbourne, Sydney
(GMT+10:00) Guam, Port Moresby
(GMT+10:00) Hobart
(GMT+10:00) Vladivostok

(GMT+08:00) Singapore
(GMT+08:00) Taipei
(GMT+09:00) Osaka, Sapporo, Tokyo
(GMT+09:00) Seoul
(GMT+09:00) Yakutsk
(GMT+09:30) Adelaide
(GMT+09:30) Darwin
(GMT+10:00) Brisbane
(GMT+10:00) Canberra, Melbourne, Sydney
(GMT+10:00) Guam, Port Moresby
(GMT+10:00) Hobart
(GMT+10:00) Vladivostok

(GMT+11:00) Magadan, Solomon Is., New Caledonia

(GMT+12:00) Auckland, Wellington
(GMT+12:00) Fiji, Kamchatka, Marshall Is.
Xplug Control Installation
Installation To Web Server

Important Information
It is highly recommended to install the Xplug Control application to the Web Server for IE 5.0. It must be installed to a Public Domain with Fixed IP address.

1. Installation:
   Copy the “xplug.ocx” file to any WEB Server table.

2. Setting (Configuration):
   From the Web Configuration menu select “System” and under the “Loading ActiveX From” input web server location (http://www.web server location.com/).

   Once the settings are completed the user now is able to access the Internet Camera from the web browser by selecting the image view – ActiveX mode.

Note:
Set your browser security level to “Low”. 


Installation To Local PC

Insert the CD-ROM into the CD-ROM drive to initiated the auto-run program once completed a menu screen will appear as follows:

To install Xplug Control click on the "Xplug Control" button to activate the installation procedure for the plug-in program.

Once executed a prompt will appear requesting the input of the desired language selection. Make the desired selection and click on “OK” to continue.

The Welcome screen will appear. Click on the “Next” button to proceed with the installation.
The License Agreement prompt will appear as below. Read the details carefully and click on the “Yes” icon to continue with the installation procedure.

Click on the “Finish” button to complete Setup of the Xplug Control Utility program for DCS-1000.
Adjust Internet Camera Focus

DCS-1000 features an exchangeable CS-type lens that can be used for different applications as necessary. It supports rotational focus control so the lens can be adjusted to focus under normal and stable conditions to maximize the image quality of DCS-1000.

To adjust the focus of the lens you need to turn the lens slowly in either clockwise or anti-clockwise direction until the desired image appears. DO NOT over turn the lens in either of the directions as it will be out of focus. Unless you want to substitute the lens DO NOT unscrew more than 1.0mm apart from the Fixed Lens Assembly.

Keep in mind while adjusting DCS-1000's focus you can review the image quality from the Web browser.

Note:
You can further adjust the DCS-1000's image quality through the Web Configuration under System Administration - Image. Please refer to Web Configuration section for further details.

Warning
Direct exposure to sunlight may cause permanent damage to the CMOS sensor. Therefore do not expose the Internet Camera’s lens directly to sunlight. When operation is required in glaring light environment, it is recommended to use an iris lens.

The Internet Camera is designed for indoor usage and if your application requires prolong exposure to sunlight, a sun visor is recommended to protect the Internet Camera.
Replacing the Lens

Since the DCS-1000 is designed with a CS- mount, the lens equipped with the DCS-1000 can be replaced with any standard C or CS lens commonly used within the surveillance industry.

Follow the instructions below to replace the supplied lens with any C or CS type lens.

1. Unscrew the DCS-1000 lens
2. C-lens only, attach the new lens to a CS-C adapter
3. Screw the new lens onto the DCS-1000. If appropriate, adjust the iris according to the prevailing light conditions.
4. Refer to Adjusting the DCS-1000 Focus on the previous page.
5. Refresh the web browser and monitor the results from the DCS-1000.
Specification

Video Specification
Resolution: 640 x 480 pixel
Sensor: 1/3” color CMOS sensor
Gain control: Automatic
Exposure: Automatic
White Balance: Automatic
Shutter: Electronics 1/60 ~ 1/15000 sec
Minimum Illumination: 2.5lux@f1.4, 3000K color
Focal Length: 6.0 mm
Aperture: F=1.8
Focus Extent: 20 cm -
Lens mounting: Fixed board lens, CS-mount type

Image (Video Setting)
Image compression: JPEG
Frame rate: 30fps@QCIF, 20fps@CIF, 3fps@VGA
Compression Rate selection: 5 level (Very Low, Low, Medium, High, Very High)
Frame rate setting: 1, 5, 7, 15, 20, auto (depends on the video format)
Video resolution: 160x120, 320x240, 640x480
Brightness control: Range 1- 128
Contrast control: Range 1- 128
Hue control: Range 1- 128

System Hardware
LAN Connector: One RJ-45 port to connect to 10/100Mbps Ethernet, auto-sensed

Generic I/O Port: Four I/O ports, two for input and two for output
Total 8-pin:
Pin 1   Input Port (1)
Pin 2   Input Port (1)
Pin 3   Input Port (2)
Pin 4   Input Port (2)
Pin 5   Output Port (1+)
Pin 6   Output Port (1-)
Pin 7  Output Port (2+)
Pin 8  Output Port (2-)

Note:
The output voltage is DC 5V and maximum current is 100mA.

LED Indicator:  Power LED (Blue)
               LAN Activity LED (Orange)

Note:
LED three mode setting can be changed by software.  (Normal / Off / Dummy)

Power Supply:  DC 5V/2.4A, switching type
Power Communication: 4.5 Watt (900mA x 5V)

Communication Support
Communication:  10/100Mbps Ethernet only
Communication protocol: HTTP, FTP, TCP/IP, UDP, ARP,
                       ICMP, BOOTP, RARP, DHCP, PPPoE

Browser Support
- Internet Explorer 5.0 or above (ActiveX & JAVA Mode – View Image for Windows OS and JAVA Mode – View Image for other OS)
- Netscape 6.0 or above (JAVA Mode – View Image)
- CPU:  Pentium II, 266 MHz or above
- Memory Size: 32 MB (64 MB recommended)
- VGA card resolution: 800x600 or above

IPView Application
- Win 98, Win 98 SE, Win 2000, Win Me, Win XP
- Pentium III, 450 MHz or above
- Memory Size of 128 MB (256 MB recommended)
- VGA card resolution of 800x600 or above

Operating environment
Operating temperature:  5°C ~ 50°C
Storage temperature:  -25°C ~ 50°C
Humidity:  5% ~ 95% non-condensing

EMI
FCC , CE , VCCI
Technical Support

D-Link provides free technical support for customers within the United States during the warranty period. U.S. customers can contact D-Link Technical Support through our web site, e-mail or by phone.

D-Link Technical Support over Telephone:
(949) 790-5290
6 a.m. to 6 p.m. Monday thru Friday

D-Link Technical Support over the Internet:
www.dlink.com
support@dlink.com

If you are a customer residing outside of the United States, please refer to the list of D-Link locations that is included in the User’s Manual.

Registration

Register your DCS-1000 at http://support.dlink.com/registration/